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                                   READ ME 

    ( Macintosh PPC only )            Version 1.0 March 18, 2000
Welcome to NodeSaVR®, the tool that splits QTVR 2.0  

multinodes into single node movies with URL hotspots 

System Requirements 

NodeSaVR 1.0 requires a Macintosh or compatible PowerPC computer system running MacOS 8 or higher.
Minimum system requirements are 5 MB of available RAM and 5 MB of free hard disk space.  Recommended
system configuration is 16 MB of available RAM and 50 MB of free hard disk space. NodeSaVR requires
QuickTime 3.0 or higher to be installed (version 4.1 recommended), and requires System 8 or higher. To view
the output created by NodeSaVR, QuickTime 3.0 or higher is also required. 

  

Quick Start 

1) Launch NodeSaVR 

2) Adjust settings 
      Select an HTML template 
      Specify single or multiple HTML file output

3) Select a multinode source movie 
      Click the "Process Movie" button 
      Select a QTVR movie file from the dialog window 
      Click "Open"

4) Select a destination for the output movies 
      Use the save dialogue box to choose a destination for the split movies 
      (Recommended) Use the "New Folder" to create a new folder 
      Enter the base file name for the output movies 
      Click "Save".
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The Menu Bar 

There are three active menu bar items in NodeSaVR: File, Edit , and Options. 

The File menu has one active item: "Quit" 
The "Quit" menu item will quit the application. 

The Edit menu has the standard items: "Cut", "Copy", "Paste", "Clear", "Select All" 
These items are available when working with the "Absolute Path" field.  

The Options menu has one active item: "Add Extra Zeros to Export Name" 
When this menu item is not check marked node file names will always be exported as "1, 2". 
When this menu item is  check marked node file names will be exported as "01, 02", if more than 9 nodes. 

  
  
  
  

The NodeSaVR Settings Window 

When NodeSaVR is launched the "Settings Window" is opened.  This window has three main group panels,
the "Custom HTML Template" panel, the "Multiple HTML Files" panel and the "Absolute path" panel. The
settings window also contains buttons to register the application (if not registered), quit the application, and to
process the source movie into single nodes. 

The non registered version of NodeSaVR will separate multinode movies, but all URL links will point to
a page on our website.  This allows users to test their movies before they purchase NodeSaVR. 

Once the application has been registered, the "Register..." button will no longer be visible, and URL links will
no longer point to our website. 
  

Custom HTML Template Check Box. 
This group panel contains controls that select the HTML file to be used as a template. 

When this box is not checked, the default template will be used. 

When this box is  checked, the "Choose..." button will be available and custom templates can be selected.  If
no template is selected, the default template will be used. Template files are text files that contain HTML
information that is used to create the output HTML files. More information on custom HTML templates is
covered later in this document. 

Template Name Field 
This field displays the file name of the selected HTML template. 

"Choose..." Button 
This button opens a dialog that allows the user to select a file to be used as the HTML
template.
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Multiple HTML Files Check Box 
This group panel contains the controls that specify options used in the export process used when outputting
HTML files. 

When this box is not checked, a single HTML file named "index.html" is generated using the selected
template. A single nodes will load in place into this single HTML page.  This method will not allow templates
to take advantage of dynamically substituted content discussed in the "HTML File Templates" section. 

When this box is  checked, HTML files will be generated for every node in the multinode source movie.
Additionally, an "index.html" file is be created to automatically jump to the default node (as specified in the
original multinode). All output HTML files can be easily edited in any text or HTML editor for customization
or additions. 

For Each Hotspot Check Box 
If this checkbox is not selected, hotspots link into the default view as specified for each
node. 

If this checkbox is  selected, an HTML file will be generated for each hotspot. This permits
the pan, tilt and zoom specified for each hotspot to be preserved. 

Link In Embed Tag Check Box 
If this checkbox is not selected, node link information will be stored embedded within the
output movies. 

If this checkbox is  selected, node link information will be stored in the corresponding HTML
files. As this information is stored in the QuickTime Embed tag, this permits easy editing and
customization. Note that QuickTime 4.1 has a bug that prevents links contained within the
Embed Tag to work correctly. (See Apple TIL 60694).  

Absolute Path Check Box 
This group panel sets the path to the location where the output files will reside. 

If this checkbox is  selected, all URL links will be preceded with the path entered in the path name field.  This
enables a single node that has been saved to a hard drive to link back to the original HTML files on a Web site.

When this checkbox is not, only the base file name will be used in the URL link. Thus, all links will be
relative. 

Path Name Field 
The text in this field will precede the base file name of the output files. Both URL and hard
drive path names are supported. If an output movie is viewed in QT Player and the Multiple
HTML Files check box was not selected then the linked nodes will load into the
QuickTime Player window and the users default browser will not be opened. 

"Process Movie..." Button 
Clicking this button will bring up an open file dialog asking to select a movie to be split up into separate
nodes.  Once a movie has been selected, a save dialog will prompt the user to provide the location and base file
name to be used to output the files.  The current settings in the Settings Window will be used for all movie that
are exported, so settings should be adjusted before clicking on this button. 
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Quit Button 
Clicking this button will quit the application. 
  

Zoom Box 
Clicking this title bar box button will reduce or enlarge the window size. 
  

Register... Button 
This button will only be visible when the application is not registered. Clicking this button will open a window
with information on how to purchase and register the application.  
  
  

HTML File Templates 

This feature of NodeSaVR exists for three reasons:  To reduce the effort involved to switch from a multinode
web tour to a single node based web tour, To allow easy selection from a pre-defined library of layouts when
creating new single node QTVR web tours, And to allow information about the each node to be dynamically
inserted into HTML files. 

The included HTML templates are meant to serve as examples to help users design and create customized
templates specific to their application.  Note that if an example template uses additional media, such as linked
images or files, these files must be manually copied into the same directory as the output movies. 

To convert an existing web page that already displays a QTVR multinode movie: 

1)  Duplicate the original HTML file 
2)  Open the file in your HTML editor 
3)  Change the name of the Embed SRC= tag from  myMovie.mov  to  %%NodeFileName%% 
4)  Change the name of the Embed HEIGHT= tag from the current value  to  %%NodeHeight%% 
5)  Change the name of the Embed WIDTH= tag from the current value  to  %%NodeWidth%%  
6)  Add the term  %%HotSpots%% to the EMBED tag. 
7)  Save the file and use it as the template for splitting the multinode apart. 

For example,  the following HTML code:  
EMBED SRC="myMultiNode.mov" WIDTH="420" HEIGHT="240" CACHE="TRUE"  

should be converted to: 
EMBED SRC="%%NodeFileName%%" WIDTH="%%NodeWidth%%" HEIGHT="%%NodeHeight%%" %%Hotspots%% CACHE="TRUE"  
  

The double percent characters tell NodeSaVR that information specific to the current node should be inserted at
the location in the HTML file. Note that: 

All text in the format of %%xyz%% will be removed from the HTML file.  
If the text between the %% characters refers to node information, then the
corresponding text will be inserted. 
If the Multiple HTML Files check box is not selected then node specific
information will not be inserted.  (All flags except for "original source movie name".) 

By using templates, different layouts and navigation features can be implemented. This permits easy creation
of different layouts and the ability to take advantage of automatic page customization specific to each node in
the multinode. 
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Tips: 
Name your source movies appropriately, for example: "MacDonald's Corporate Headquarters" 
Name your nodes descriptively, for example: "the Accounting Division", "the CEO's Office", "Board
Room # 5", "Storage room". 

This permits sentences to be generated that integrate information from each node: 
"This is the CEO's Office at MacDonald's Corporate Headquarters. " 

If your multinode does not have node names you can add them with VRTools' "conVRter", or you could use
numbers: 
"This is Room 6 at MacDonald's Corporate Headquarters. " 

With no prior planning you will probably end up with something like: 
"This is Node 6 at MacD HQ.mov. " 

These special %% terms can be inserted into any part of the HTML template so you can do really creative
things like: 
<img SRC="/images/nodeLogo%%NodeNumber%%.gif" BORDER=0 align=LEFT> 

This would load a different image into each node page when "Multiple HTML Files" is selected. 

You can also use the %% terms in the title and meta tags: 

<head> 
     <title> This is a QuickTime Virtual Reality Tour of %%MultiNodeFileName%%</title> 
</head>  
  

NodeSaVR Movie Terms Table

   REQUIRED   Term must always be included in template. 
 Can only be used when the "Multiple HTML Files" checkbox is selected. 
  Can only be used when the "For Each Hotspot" checkbox is selected.

File name of source movie: %% %%  
File name of node: %% %%

File name without extension: %% %% 
Number of the node: %% %%

Text name of node in source movie: %% %%
ID of node in source movie: %% %%
Width of the node in pixels: %% %%
Height of the node in pixels: %% %%

Number of Hotspots: %% %%
Pan angle used to enter node: %% %%
Tilt angle used to enter node: %% %%

Zoom angle used to enter node: %% %%
 Link, Pan, Tilt, Zoom infor for PlugIn:  %% %%
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There are sample HTML templates in the "HTML Templates" folder to get you started.  You should definitely
plan out your template if you are using NodeSaVR to create HTML files for each Hotspot in every node, in
order to maintain link views.  Without proper planning you may end up with a big editing job, since a 10 node
movie with 10 hotspots in each node will generate 111 HTML files.  
  
  

Try out the "Number Fun" template with the "Multiple HTML" files checked and the "For Each Hotspot"
checked for a good example of how to reduce your workload and maximize automation. 

Advanced techniques are demonstrated using the "JavaScript Fun" template. (A javascript capable browser is
required.) 

Remember that NodeSaVR can only modify "%%" terms, and does not actually add any HTML code. 

  
  

Known Issues 

Movies that were not authored by tools that conform to Apple's QTVR format specification are not supported
by NodeSaVR. 

NodeSaVR does not currently preserve tracks that it does not understand. This includes graphics tracks and
wired sprites made with Third Party authoring tools such as LiveStage. The only extra tracks supported in
version 1.0 are MapSaVR, SoundSaVR and RevolVR tracks.  Support of additional track types may be
addressed in subsequent versions. If you are interested in having a specific track type supported, please
contact dev@smgVR.com. 

If you have problems with a particular movie file, please send it to SMG for testing. The E-Mail address for
test movies is CustomerProbMovies@smgVR.com.  You should send the original movie before it has
been run through NodeSaVR, along with a detailed description of the problem. 

  
  

Reporting problems 

If you believe that you have found a bug in NodeSaVR, please ensure that you can reproduce it, and check if it
still occurs when starting up with only the required Apple extensions. Also make sure that all source movies
and sounds play correctly in the QuickTime Player before they are brought into NodeSaVR. 

If problems persist, please e-mail a detailed description of the problem, how it is triggered, and if possible an
example source movie, as well as the name of the program the movie was authored with, to
CustomerProbMovies@smgVR.com.  
  

NodeSaVR® - Copyright 1999, 2000 SQUAMISH Media Group, Inc. All rights reserved. 
NodeSaVR and associated logos are registered trademarks of SQUAMISH Media Group, Inc. 


